
آموزش فارسی افتر افکت متحرک سازی اشکال
)CS6 نسخه این آموزش و توصیه شده( CS4  :نسخه های قابل اجرا

مدت زمان تکمیل: 1 ساعت و 30 دقیقه
سطح آموزش: متوسط

تهیه و تنظیم: فرشاد زرین

لایه های شکلی بصورت خودکار هنگامی که آن ها را رسم می کنید ایجاد می شوند. شما می توانید آن ها را تغییر داده و یا 
سفارشی کرده و به اشکال جدید دیگری تبدیل نمایید. در این پروژه می خواهیم پس زمینه پویایی با انیمیشن بوسیله ای 

لایه های شکلی ایجاد نماییم. همچنین در ادامه به فایل ویدئویی وارد شده افکت کارتونی اضافه می کنیم.
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1. پس از دانلود فایل های پروژه و خارج کردن آن از حالت فشرده پوشه Lesson04 را در محل مناسب کپی نمایید. 

 Close نمایش داده خواهد شد. روی دکمه Welcome را باز نمایید. پنجره خوشامد گویی Adobe After Effects 2. نرم افزار
کلیک نمایید.

lesson04. فایل را با نام Lesson04/Finished_Project را انتخاب نمایید.  در پوشه Save As گزینه File > Save As از منوی
aep ذخیره نمایید.

Lesson04/ در مسیر Assets وارد پوشه Import File دابل کلیک کرده و سپس در کادر Project 3. در ناحیه خالی پانل
Assets شوید. فایل های DJ.mov و gc_adobe_dj.mp3 را انتخاب کرده و روی دکمه Open کلیک کنید.

4. از منوی File > New گزینه New Folder را انتخاب نمایید. نام پوشه جدید را در پانل Assets ،Project وارد کرده و کلید 
Enter را فشار دهید. هر دو فایل وارد شده را درون این پوشه درگ نمایید.

Composition Settings نام  Ctrl+N فشار داده تا پنجره ساخت ترکیب جدید باز شود. در کادر محاوره ای  5. کلید های 
 )Duration( را انتخاب و مقدار زمان NTSC DV ترکیب را Shapes background وارد کرده و از فهرست Preset گزینه 

پروژه را هم روی 10:00 ثانیه تنظیم نمایید. در نهایت روی OK کلیک نمایید.

>
>

01

ال
شک

ی ا
ساز

ک 
حر

 مت
ت

فک
ر ا

افت
ی 

رس
 فا

ش
وز

آم

W
W

W
.FA

RA
GR

AP
HI

C.
CO

M
W

W
W

.FA
RA

GR
AP

HI
C.

CO
M

W
W

W
.FA

RA
GR

AP
HI

C.
CO

M
W

W
W

.FA
RA

GR
AP

HI
C.

CO
M

W
W

W
.FA

RA
GR

AP
HI

C.
CO

M
W

W
W

.FA
RA

GR
AP

HI
C.

CO
M

www.fa
rag

rap
hic

.co
m



>
>

02

ال
شک

ی ا
ساز

ک 
حر

 مت
ت

فک
ر ا

افت
ی 

رس
 فا

ش
وز

آم

W
W

W
.FA

RA
GR

AP
HI

C.
CO

M
W

W
W

.FA
RA

GR
AP

HI
C.

CO
M

W
W

W
.FA

RA
GR

AP
HI

C.
CO

M
W

W
W

.FA
RA

GR
AP

HI
C.

CO
M

W
W

W
.FA

RA
GR

AP
HI

C.
CO

M
W

W
W

.FA
RA

GR
AP

HI
C.

CO
M

توانید  می  که  اینست  معمولی  های  لایه  خلاف  بر  شکل  های  لایه  از  استفاده  امتیازات  از  یکی   :1 شماره  آموزشی  نکته   «
گرادیانت های رنگی خطی و شعاعی به آن اضافه کنید. 

افتر افکت شامل 5 ابزار رسم شکل می باشد: Polygon ،Ellipse ،Rounded Rectangle ،Rectangle و Star. هنگامی که یک 
شکل را بصورت مستقیم در پانل Compostion رسم کنید، افتر افکت لایه شکل را به ترکیب اضافه می کند. شما می توانید 
خط حاشیه و رنگ شکل را تغییر داده، حالت آن را تغییر و یا به آن انیمیشن اضافه کنید. همچنین می توانید تمام تنظیمات 

شکل را در پانل Timeline در طول زمان مشخص متحرک کنید.
این ابزار های رسم شکل همچنین می توانند ماسک هم رسم نمایند. ماسک ها برای مخفی کردن و یا نمایان کردن بخشی 
از تصویر به کار گرفته می شوند. هنگامی که یک ابزار رسم شکل را انتخاب می کنید می توانید مشخص کنید که شکل و یا 

ماسک رسم کنند. «

رسم شکل:

Rectangle )ابزار مستطیل( را از نوار ابزار انتخاب نمایید. اشاره گر ماوس را در ناحیه بالایی و سمت چپ پانل  6. ابزار 
تا پایین و سمت راست ناحیه کاری درگ نمایید، طوری که تمام ناحیه را پوشش  Compostion قرار داده و سپس آن را 
دهد. برای تنظیم اندازه هم می توانید از گیره های اطراف شکل استفاده نمایید. افتر افکت یک لایه شکل جدید در پانل 

Timeline اضافه خواهد کرد.
توجه کنید که در نوار تنظیمات رنگ خط حاشیه شکل Stroke را با کلیک روی کلمه Stroke و انتخاب آیکون اول از سمت چپ 

در کادر Stroke Options غیر فعال نمایید.
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 R=100 G=185 B=240 روی آیکون نشانه رنگ سفید کلیک کرده و رنگ آن را به مقدار Gradient Editor 9. در کادر
تغییر دهید.

حال روی آیکون نشانه رنگ سیاه کلیک کرده و رنگ آن را به R=10 G=25 B=150 تغییر دهید. روی OK کلیک کرده تا 
گرادیانت رنگی اعمال شود.

برای تغییر مقادیر RGB روی عدد کنار G ،R و B به ترتیب کلیک نمایید. 
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اعمال گرادیانت رنگی:

7. روی کلمه Fill در نوار تنظیمات کلیک نمایید. آیکون Radial Gradient )آیکون اول از سمت راست( را انتخاب کرده و 
روی OK کلیک نمایید.

8. حال در نوار تنظیمات روی آیکون رنگ Fill Color Box کلیک کرده تا پنجره ویرایش گرادیانت رنگی باز شود.
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تغییر تنظیمات گرادیانت:

 Gradient Fill تنظیمات Timeline 10. در این مرحله می خواهیم اندازه ناحیه مرکزی گرادیانت را افزایش دهیم. در پانل
را با کلیک روی آیکون های فلش Shape Layer 1 > Contents > Rectangle 1 > Gradient Fill 1 باز نمایید. 

مقدار Start Point را به 0,225 و مقدار End Point را به 0,740 تغییر دهید.

 Background را فشار دهید. نام لایه را به Enter را مخفی کنید. لایه را انتخاب کرده و کلید Shape Layer 1 11. تنظیمات لایه
تغییر داده و کلید Enter را مجدداً فشار دهید.

لایه را با کلیک روی مربع خالی ستون قفل نمایید تا بصورت تصادفی انتخاب نشود.

رسم شکل چند ضلعی:

بصورت پیش فرض ابزار رسم شکل چند ضلعی )Polygon( شکل را بر اساس آخرین تنظیماتی که داشته است رسم می 
کند. در هر حال شما می توانید بوسیله تنظیمات آن تعداد نقاط، موقعیت، چرخش، شعاع بیرونی و دیگر تغییرات را روی آن 

انجام دهید.

12. ابزار Polygon را که در زیر ابزار Rectangle مخفی شده است را انتخاب نمایید. یک شکل چند ضلعی روی صفحه کاری 
رسم نمایید. 
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13. در پانل Timeline تنظیمات شکل را از مسیر Layer 1 > Polystar 1 > Polystar Path 1 باز نمایید.
 Outer را به 150 و Outer Radius را به 0 درجه تغییر دهید. همچنین مقادیر Rotation را به 6 و مقدار Points مقدار

Roundness را به %500- تغییر دهید. بعد از انجام تغییرات تنظیمات شکل را مخفی کنید.

14. روی کلمه Fill در پانل ابزار کلیک کرده و در کادر Fill Options روی آیکون رنگ ساده )Solid Color( کلیک کرده و 
سپس روی OK کلیک نمایید.

روی آیکون رنگ Fill کلیک کرده و سپس در کادر رنگ مقدار رنگ R=250 G=250 B=0 را وارد نمایید.
روی آیکون رنگ خط حاشیه Stroke کلیک کرده و سپس در کادر رنگ مقدار رنگ R=230 G=230 B=230 را وارد نمایید.

مقدار ضخامت خط حاشیه شکل را هم )Width( به 5 پیکسل تغییر دهید.
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<<تصویر در صفحه بعدی
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چرخش شکل:

فرمان Twist اشکال را از مرکز می چرخاند. چرخش شکل در افتر افکت در دو جهت موافق عقربه های ساعت و مخالف عقربه 
های ساعت صورت می پذیرد. مقدار مثبت موافق عقربه ها و مقادیر منفی مخالف عقربه های ساعت شکل را می چرخاند.

15. در پانل Timeline روی آیکون فهرست Add برای لایه Shape Layer 1 کلیک کرده و گزینه Twist را انتخاب نمایید.

16. تنظیمات Twist 1 را باز نمایید. 
مقدار Angle را به 160 تغییر دهید. تنظیمات Polystar 1 را مخفی کرده و پروژه را تا اینجای کار ذخیره نمایید.
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تکرار اشکال:

17. لایه Shape Layer 1 را در پانل Timeline انتخاب نمایید. روی آیکون فهرست Add کلیک کرده و گزینه Repeater را 
انتخاب نمایید.

تنظیمات Repeater 1 را باز نمایید. مقدار Copies را به 5 تغییر دهید. 4 کپی از شکل ایجاد خواهد شد.

18. تنظیمات بخش Transform: Repeater 1 را گسترش دهید.
مقدار Position را به 345,0 تغییر دهید. برای افزایش فاصله بین اشکال از مقدار x بیشتری می توانید استفاده کنید.
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<<تصویر در صفحه بعدی
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19. تنظیمات قسمت Transform: Repeater 1 را مخفی نمایید. 
لایه Shape Layer 1 را انتخاب کرده و کلید P را فشار داده تا تنظیمات مربوط به موقعیت نمایان شود. مقادیر را به 50,65- 

تغییر دهید.
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 Scale را فشار داده تا تنظیمات مربوط به اندازه شکل نمایان شود. مقدار S را انتخاب کرده و کلید Shape Layer 1 20. لایه
را به %50 تغییر دهید. کلید S را فشار داده تا تنظیمات مخفی شوند.

21. تنظیمات بخش Shape Layer 1 > Contents را گسترش دهید.
لایه Shape Layer 1 را انتخاب و از فهرست بازشوی Add گزینه Repeater را انتخاب نمایید.

تنظیمات بخش Repeater 2 > Transform: Repeater 2 را گسترش دهید. 
مقدار Position را به 0,385 تغییر دهید. تنظیمات Repeater 2 را مخفی نمایید.
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چرخش اشکال:

22. در این مرحله می خواهیم اشکال روی صفحه را در حالت چرخش متحرک کنیم. 
در پانل Timeline مسیر Shape Layer 1 > Contents > Polystar 1 > Transform: Polystar 1 را گسترش دهید.

کلید Home را فشار داده تا نشان گر زمان در زمان 00:00 قرار بگیرد.
روی آیکون کرونومتر ویژگی Rotation کلیک کرده تا فریم کلیدی ایجاد شود. 

کلید End را فشار داده تا نشان گر زمان به انتهای پروژه برود.
مقدار Rotation را به 3x + 0 تغییر دهید. این تغییر باعث می شود شکل در مدت 10 ثانیه 3 بار به دور خودش بچرخد.

تنظیمات لایه Shape Layer 1 را مخفی کنید.
نشان گر زمان جاری را بصورت دستی درگ کرده تا انیمیشن اشکال را مشاهده نمایید.

ترکیب اشکال با پس زمینه:

کنتراست رنگ اشکال با رنگ پس زمینه بسیار زیاد است. در ادامه وقتی می خواهیم فایل ویدئویی روی پروژه قرار دهیم 
مقدار تمرکز و توجه به آن کم خواهد شد. بنابر این بوسیله حالت های Blending اشکال را با پس زمینه ترکیب می کنیم.

23. روی دکمه Toggle Switches/Modes در پایین پانل Timeline کلیک نمایید. 
از فهرست بازشوی Mode گزینه Overlay را برای لایه Shape Layer 1 انتخاب نمایید.
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24. لایه Shape Layer 1 را انتخاب کرده و کلید T را فشار دهید تا تنظیمات مربوط به Opacity لایه نمایان شود.
مقدار Opacity را به %25 تغییر دهید.

کلید T را فشار داده تا ویژگی Opacity مخفی شود.
لایه Shape Layer 1 را انتخاب کرده و کلید Enter را فشار دهید. نام لایه را به Suns تغییر داده و کلید Enter را یکبار دیگر 

فشار دهید.
لایه را قفل کرده تا بصورت تصادفی آن را انتخاب نکنید.

رسم ستاره:

در این مرحله می خواهیم با ابزار Star ستاره ای روی پس زمینه رسم نماییم. سپس آن را تغییر شکل و متحرک کنیم.

25. ابزار Star را که در زیر ابزار Polygon قرار دارد از نوار ابزار انتخاب نمایید.
روی آیکون رنگ Fill در نوار تنظیمات کلیک کرده و سپس در کادر رنگ، مقدار رنگ R=75 G=120 B=200 را وارد نمایید.

روی کلمه Stroke کلیک کرده و در کادر باز شده آیکون None را انتخاب تا رنگ حاشیه غیر فعال باشد.
حال بوسیله ابزار Star ستاره ای در مرکز صفحه رسم نمایید. افتر افکت  یک لایه شکل با نام Shape Layer 1 ایجاد خواهد 

کرد.
در پانل Timeline مسیر Shape Layer 1 > Polystar 1 > Polystar Path 1 را گسترش دهید.

مقدار Points را به 6 و مقدار Rotation را 150 درجه تغییر دهید.
www.faمقدار Inner Radius را به 50 و مقدار Outer Radius را به 90 تغییر داده تا شکل ستاره تغییر حالت داده شود.
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26. تنظیمات بخش Transform: Polystar 1 را گسترش دهید.
مقدار Position را به 70- , 180- تغییر دهید.

تنظیمات Polystar 1 را مخفی کنید.

:Pucker & Bloat اعمال فرمان

افتر افکت شامل فرمان قدرتمندی به نام Pucker & Bloat می باشد که بوسیله این فرمان می توانید شکل را به طرف بیرون 
و یا داخل تغییر شکل داد.

27. لایه Shape Layer 1 را انتخاب نمایید.
از فهرست باز شوی Add گزینه Pucker & Bloat را انتخاب نمایید.

تنظیمات بخش Pucker & Bloat 1 را گسترش دهید.
مقدار Amount را به 125- تغییر دهید.
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کپی کردن اشکال:

28. لایه Shape Layer 1 را انتخاب کرده و سپس از فهرست Add گزینه Repeater را انتخاب نمایید.
تنظیمات Repeater 1 را گسترش داده و مقدار copies را به 6 تغییر دهید.

حال 6 ستاره روی صفحه داریم.
تنظیمات بخش Transform: Repeater 1 را گسترش دهید.

مقدار Position را به 0,0 و مقدار Rotation را به 230 درجه تغییر دهید.

بدلیل ویژگی چرخش در فرمان Repeater هر ستاره به دور نقطه مرجع خود خواهد چرخید.

29. مقدار End Opacity را به %65 تغییر دهید. هر ستاره نسبت به ستاره قبلی شفاف تر خواهد شد.
تنظیمات Repeater 1 را مخفی کنید. 

لایه Shape Layer 1 را انتخاب کرده و از فهرست Add یکبار دیگر گزینه Repeater را انتخاب نمایید.
تنظیمات Repeater 2 > Transform: Repeater 2 را گسترش دهید.

مقدار Position را به 140,0- و مقدار Rotation را به 40 درجه تغییر دهید.
مقدار Scale را هم به %80 کاهش داده تا اندازه هر ستاره نسبت به ستاره قبلی کوچک تر شود.

مقدار End Opacity را به %0 تغییر دهید.
تنظیمات Repeater 2 را مخفی کرده و سپس پروژه را با فشار دادن کلید های Ctrl+S ذخیره نمایید.

چرخش اشکال:

30. تنظیمات بخش Polystar 1 > Transform: Polystar 1 را در پانل Timeline گسترش دهید.
کلید Home را فشار داده تا نشان گر زمان جاری به ابتدای خط زمان انتقال داده شود.

روی آیکون کرونومتر ویژگی Rotation کلیک کرده تا فریم کلیدی اولیه ایجاد شود.
کلید End را فشار داده تا به انتهای خط زمان بروید.
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مقدار Rotation را به 180 درجه تغییر دهید.

را  انیمیشن چرخش شکل  تا  و راست درگ کرده  به سمت چپ   Timeline پانل  در  را  زمان  گر  نشان  31. بصورت دستی 
مشاهده کنید.

نام لایه Shape Layer 1 را به Stars تغییر داده و سپس کلید Enter را فشار دهید.
لایه Stars را قفل نمایید.

ترکیب کردن لایه های ویدئویی و صوتی:

اضافه کردن فایل های صوتی و ویدئویی:

Composition اضافه خواهید کرد. Project کردید. حال آن ها را به پانل  شما فایل هایی را در ابتدای پروژه وارد پانل 
کلیپ ویدئویی DJ.mov دارای پس زمینه نمی باشد و در کانال Alpha رندر شده است. درباره پس زمینه های شفاف و واژه 

keying در پروژه های آینده مطالب کاملی را خواهید آموخت.

32. کلید Home را فشار داده تا به ابتدای پروژه انتقال داده شوید.
پوشه Assets را در پانل Project باز نمایید.

فایل DJ.mov را درون پانل Timeline در بالای تمام لایه ها درگ کنید.
فایل صوتی gc_adobe_dj.mp3 را از پانل Project زیر تمام لایه ها در پانل Timeline درگ نمایید.

لایه صوتی را قفل کرده تا بصورت تصادفی آن را انتخاب نکنید.

برش ناحیه کاری:

کلیپ Dj.mov 5 ثانیه می باشد، اما مدت زمان پروژه 10 ثانیه است. اگر این پروژه را رندر نمایید فایل ویدئویی در میانه 
پروژه ناپدید خواهد شد. بنابراین باید مدت زمان رندر پروژه را به 5 ثانیه تغییر دهیم.
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33. نشان گر زمان را به ثانیه 5 درگ نمایید.
کلید N را فشار داده تا نقطه پایانی ناحیه کاری روی زمان جاری قرار بگیرد.

اضافه کردن افکت کارتونی:

34. لایه DJ.mov را در پانل Timeline انتخاب نمایید.
از منوی Effect > Stylize گزینه Cartoon را انتخاب نمایید.

» نکته آموزشی شماره 2: افکت کارتونی 3 عملیات را روی لایه انجام می دهد. ابتدا جزئیات بسیار زیادی را از لایه حذف می 
کند. بنابراین این افکت روی لایه های ویدئویی نسبت به لایه های گرافیکی بهتر کار می کند. سپس نواحی مرزی اشکال را 

بر اساس مقادیر روشنایی آن ها برجسته تر می کند. سرانجام تعداد رنگ ها را در لایه کاهش می دهد. «

35. در پانل Effect Controls از فهرست Render گزینه Fill را انتخاب نمایید. 
مقدار Detail Radius را به 20 و مقدار Detail Threshold را به 50 تغییر دهید.

این تنظیمات مقدار حذف جزئیات را کنترل می کنند.
در ناحیه Fill مقدار Shading Steps را به 10 و مقدار Shading Smoothness را به 70 تغییر دهید.

تنظیمات Shading مربوط به چگونگی کاهش رنگ می باشند.

36. از فهرست Render گزینه Edges را انتخاب کرده تا به تنظیمات نواحی مرزی کنترل داشته باشیم. لایه بصورت موقت 
سیاه و سفید می شود.

در ناحیه Edge مقدار Threshold را به 1.25 و مقدار Width را به 1 تغییر دهید.

<<تصویر در صفحه بعدی
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این تنظیمات تعداد خطوط سیاه رنگ را کاهش می دهند.
مقدار Softness را در حالت پیش فرض باقی نگه داشته اما مقدار Opacity را به %60 تغییر دهید.

37. از فهرست Render گزینه Fill & Edges را انتخاب کرده تا رنگ ها به ویدئو باز گردند.
قسمت تنظیمات Advanced را گسترش دهید.

مقدار Edge Enhancement را به 50 تغییر دهید تا لایه وضوح بیشتری داشته باشد.
مقدار Edge Black Level را به 2 تغییر دهید تا نواحی بیشتری از ویدئو با رنگ سیاه پر شود. این تنظیم حالت کارتونی تری 

به ویدئو می دهد.

38. لایه DJ.mov را قفل کرده تا بصورت تصادفی آن را انتخاب نکنید.

اضافه کردن نوار عنوان:

با افکت و  با استفاده از ابزار مستطیل و سپس ابزار متن در قسمت پایینی پروژه نوار عنوان  در این بخش می خواهیم 
انیمیشن اضافه کنیم.

39. ابزار مستطیل را )Rectangle( که در زیر ابزار ستاره )Star( مخفی شده است را انتخاب نمایید.
روی آیکون رنگ Fill Color کلیک کرده و رنگ زرد روشنی را انتخاب نمایید.

روی کلمه Stroke در نوار تنظیمات کلیک کرده و در کادر باز شده آیکون Solid Color را انتخاب و روی OK کلیک نمایید.
روی آیکون رنگ Stroke Color کلیک کرده و رنگ خاکستری روشنی را برای حاشیه انتخاب نمایید.

مقدار ضخامت خط حاشیه را Stroke Width را به 10 پیکسل تغییر دهید.
حال بوسیله ابزار Rectangle مستطیلی در پایین پانل Composition و با ارتفاع تقریبا 50 پیکسل رسم نمایید.
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در پانل Timeline تنظیمات بخش Rectangle 1 > Rectangle Path 1 را گسترش دهید.
حالت لینک بودن اندازه را با کلیک روی آیکون زنجیر غیر فعال نمایید. سپس اندازه Size را به 680,50 تغییر دهید.

تنظیمات بخش Stroke 1 را گسترش داده و مقدار Stroke Opacity را به %30 تغییر دهید.

40. تنظیمات Rectangle 1 را مخفی نمایید.
لایه Shape Layer 1 را فعال کرده و سپس از منوی Add گزینه Wiggle Paths را انتخاب نمایید.

تنظیمات بخش Wiggle Paths 1 را گسترش داده و سپس مقدار Size را به 150 و مقدار Detail را به 80 تغییر دهید.
از فهرست Points گزینه Smooth را انتخاب نمایید.

مقدار Wiggle/Second را به 5 تغییر دهید.
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41. نشان گر زمان را بصورت دستی به سمت چپ و راست درگ نمایید تا انیمیشن حالت موج صدا را مشاهده کنید.
تمامی تنظیمات را برای لایه مخفی نمایید.

نام لایه را به Lower Third تغییر و سپس لایه را قفل نمایید.

اضافه کردن متن:

42. کلید Home را فشار داده تا به ابتدای زمان پروژه بروید.
ابزار Horizontal Type را در نوار ابزار انتخاب کرده و سپس در پانل Character فونتی ساده مثل Arial Black را انتخاب 

کرده و اندازه آن را به 60 پیکسل تغییر دهید.
روی آیکون رنگ Fill Color کرده و رنگ آن را به سیاه تغییر دهید، سپس روی آیکون رنگ Stroke Color کلیک کرده و رنگ 

سفید را برای آن انتخاب نمایید.
مقدار ضخامت خط Stroke Width را به 2 پیکسل تغییر دهید.

43. روی پانل Composition کلیک کرده و سپس کلمه مورد نظر خود را تایپ نمایید.
با استفاده از ابزار Selection موقعیت متن را روی شکل موج صدا قرار دهید.

انتخاب  را   Browse Presets گزینه   Animation منوی  از  و سپس  کرده  انتخاب   Composition پانل  در  را  متنی  44. لایه 
نمایید.

 3D Rotate In By 3 شوید. روی افکتD Text و سپس وارد پوشه Text ابتدا وارد پوشه Adobe Bidge در پنجره برنامه
Character دابل کلیک کرده تا انیمیشن به متن اضافه شود.

<<تصویر در صفحه بعدی
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45. در پانل Preview روی دکمه RAM Preview کلیک کرده تا تمام پروژه را مشاهده کنید.
توجه: بدلیل اعمال افکت کارتون زمان رندر پروژه کمی طولانی تر خواهد بود.

برای متوقف کردن نمایش پروژه کلید Space را فشار دهید.
پروژه در این مرحله به پایان رسید.

:Brainstorm استفاده از ویژگی

ویژگی Brainstorm به شما اجازه می دهد تا نسخه های جدیدی از پروژه خود را با تنظیمات مختلف ایجاد نمایید. برای استفاده 
از ویژگی Brainstorm لایه و یا لایه های مورد نظر خود را انتخاب و سپس آیکون Brainstorm را فعال نمایید.

کادر محاوره ای Brainstorm حالت های مختلفی از پروژه شما را بر اساس تنظیمات تصادفی نمایش می دهد. شما می توانید 
یک یا چند حالت را بر اساس نیاز خود ذخیره نمایید.
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46. پروژه را ذخیره کرده و از منوی File گزینه Save As را انتخاب نمایید. نام پروژه جدید را به Brainstorm تغییر داده و 
آن را در پوشه Lesson04/Finished Project ذخیره نمایید. 

لایه Suns را در پانل Timeline از حالت قفل خارج نمایید.
روی آیکون Solo لایه Suns و Background را کلیک کرده تا تنها این دو لایه نمایش داده شوند.

47. تنظیمات لایه Suns را گسترش داده و سپس گزینه Contents را انتخاب نمایید.
روی آیکون Brainstorm در بالای پانل Timeline کلیک کرده تا کادر محاوره ای Brainstorm باز شود.

48. مقدار شدت تصادفی کردن تنظیمات افکت ها را در کادر Randomness می توانید مشخص کنید. مقدار پیش فرض 
%25 می باشد. برای تغییرات قابل توجه مقدار %100 را می توانید وارد کنید.

روی دکمه Brainstorm کلیک کرده تا پروژه های مختلف بر اساس مقدار Rnadomness تغییر کنند.
با هر بار کلیک روی دکمه Brainstorm تنظیمات مختلف بر اساس مقداری که شما مشخص کرده اید نمایش داده می شوند.

<<تصویر در صفحه بعدی
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49. هر حالتی را که مایل هستید با قرار دادن اشاره گر ماوس روی آن و کلیک روی آیکون تیک مارک می توانید انتخاب و 
ذخیره کنید.<<پایان<<

<<موفق باشید<<

هر گونه سوال و مشکل خود را درباره این آموزش در سایت پرسش و پاسخ فرا گرافیک مطرح کنید.
http://forum.faragraphic.comwww.fa
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